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• Please note that the workshop is aimed to be a brief 
introduction to the topic and this PowerPoint is 
primarily designed to support the flow of the 
workshop. It cannot be seen as either an exclusive 
or exhaustive resource on the statistical concepts 
which are introduced in this course. You are 
encouraged to refer to peer-reviewed books or 
papers that are listed throughout the presentation. 

• It is acknowledged that a limited number of slides 
have been adapted from presentations produced by 
the previous statistical consultant (Kylie Lange) and 
a colleague with whom I worked with in the past (Dr 
Kelvin Gregory). 
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Statistical 
Consulting 
Website

http://www.flinders.
edu.au/library/rese
arch/eresearch/stati
stics-consulting/ 

or go to Flinders
University Website 
A-Z

Index S 
Statistical

Consultant

Introductory Level
• Introduction to IBM SPSS 
• Introduction to Statistical Analysis 

IBM SPSS - Intermediate Level
• Understanding Your Data (Descriptive 

Statistics, Graphs and Custom Tables)
• Correlation and Multiple Regression 

• Logistic Regression and Survival 
Analysis 

• Basic Statistical Techniques for Difference 
Questions 

• Advanced Statistical Techniques for 
Difference Questions 

• Longitudinal Data Analysis -
Repeated Measures ANOVA

• Categorical Data Analysis 

IBM SPSS - Advanced Level
• Structural Equation Modelling using Amos 
• Linear Mixed Models 

• Longitudinal Data Analysis - Mixed and 
Latent Variable Growth Curve Models

• Scale Development
• Complex Sample Survey Design / ABS and 

FaHCSIA Confidentialised Datasets
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??? SPSS / PASW / IBM SPSS ???

• In late 2009 SPSS Inc. was taken over by IBM Company 
and the software changed its official name twice over the 
period of one year. From SPSS it was relabelled to PASW 
(Predictive Analytics Software) and later to IBM SPSS. 
Consequently, there may be books, online resources, etc. 
that use either of those different names but in fact refer to 
the same software. 

• SPSS
– Statistical Package for the Social Sciences

• PASW
– Predictive Analytics Software

• IBM SPSS Statistics
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(1) How to 
check?

START SOFTWARE 
HELP  ABOUT

(2) How to cite? 
(Examples with APA Style)

• SPSS Inc. Released 2007. SPSS for Windows, 
Version 16.0. Chicago, SPSS Inc. 

• SPSS Inc. Released 2008. SPSS Statistics for 
Windows, Version 17.0. Chicago: SPSS Inc. 

• SPSS Inc. Released 2009. PASW Statistics for 
Windows, Version 18.0. Chicago: SPSS Inc. 

• IBM Corp. Released 2010. IBM SPSS Statistics 
for Windows, Version 19.0. Armonk, NY: IBM 
Corp. 

• IBM Corp. Released 2011. IBM SPSS Statistics 
for Windows, Version 20.0. Armonk, NY: IBM 
Corp. 

• IBM Corp. Released 2012. IBM SPSS Statistics 
for Windows, Version 21.0. Armonk, NY: IBM 
Corp.

SPSS / PASW / IBM SPSS
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IBM SPSS on Flinders University

• Flinders University has licence for number of IBM SPSS products 
(versions 19, 20, 21) covering following modules:
– IBM SPSS Statistics Base
– IBM SPSS Regression
– IBM SPSS Advanced Statistics 
– IBM SPSS Complex Samples
– IBM SPSS Categories
– IBM SPSS Exact Tests
– IBM SPSS Missing Values
– IBM SPSS Forecasting
– IBM SPSS Custom Tables
– IBM SPSS Conjoint 
– IBM SPSS Statistics Programmability Extension
and AMOS

• For details explaining various modes of obtaining access to the 
software go to 

http://www.flinders.edu.au/library/research/eresearch/statistics-consulting/spss-
licenses-and-technical-support/licenses-for-university-and-home.cfm
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Data used
(1) Two data sets describing the survival status 
of individual passengers on the Titanic are used. 
More information about them can be found in 
here:
http://lib.stat.cmu.edu/S/Harrell/data/descriptions
/titanic.html 

(2) Openly available simplified data from PISA 
2003 Study
(The Programme for International Students 
Assessment)
http://www.pisa.oecd.org  
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Exercise 1

• SPSS has three “Windows” that we will use
– Data Editor

• In this view you can enter data and change the characteristics of 
variables

• You can now have multiple datasets open at once

– Syntax Editor
• In this view you can write and run commands that will perform 

various statistical procedures

– Output Viewer
• And in this view you will see the results of the statistical procedures 

that you have performed

• Entering data into SPSS
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Few definitions
• Variable

– Any characteristic or attribute of persons, objects, or 
events that can take on different numerical values

• Observation
– Is a record or notation made from observing a 

phenomenon

• Datum
– A single observation

• Data
– May be measurements or observations of a variable

• Case
– Typically a person being studied
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Enter the Variable Details
• Variables names

– Name must begin with a letter

– Remaining characters can be any letter, and digit, a period, or 
the symbols @,#,_,$

• BUT make the  name meaningful

– Variable names cannot end with a period (.)

– Avoid ending the name with an underscore (_)

– Cannot be one of the reserved key words
• ALL, AND, BY, EQ, GT, LE, LT, NE, NOT, OR, TO WITH

– Can be a mixture of upper and lowercases
• But best to use all lowercases

– Can be long
• But best to keep to 8 characters long
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Variable View

• Type: numeric, string, date, currency, …

• Width: variable width; can also be set 
through Type

• Decimals: number of decimal places 
displayed in the Data View

• Label: 256 character description of the 
variable; used in output tables and charts
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Variable View

• Values: coding scheme used (eg, 1=Male, 
2=Female, 9=Unknown)

• Missing: code(s) used to denote a missing 
response (eg, 9, 99, -1)

• Columns: width of column in Data View

• Align: alignment of data in Data View

• Measure: measurement level (Scale, 
Ordinal, Nominal)
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Types of Data
Many different ways of classifying data
• Categorical or discrete data

– When data are classified into exclusive categories
• For example, male or female

• Categorized data
– When a categorical data is thought to have an underlying 

distribution
• Student responses to a test (wrong or right) have an underlying 

distribution of proficiency (or ability)

• Numerical data
– Discrete

• There are gaps between the numbers
– Continuous

• There are no gaps between the numbers
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Levels of Measurement and Measurement Scales

Interval Data

Ordinal Data

Nominal Data

Height, Age, Weekly 
Food Spending

Service quality rating, 
Student letter grades

Marital status, Type of car 
owned, Gender/Sex

Ratio Data

Temperature in Celsius, 
Standardized exam score 

Categories (no  ordering 
or direction)

Ordered Categories 
(rankings, order, or scaling) 

Differences between 
measurements but no 
true zero

Differences between 
measurements, true 
zero exists

EXAMPLES:



8

Pawel Skuza 2013Pawel Skuza 2013

Specify the Measurement Type

• Typically you will have ordinal or nominal
– Nominal

• Numbers do not carry any real meaning

– Ordinal
• Numbers carry rank meanings only

– Scale
• Factional values make sense

For more information refer for example to Garson, G. D. 
(2012). Measurement Levels. Asheboro, NC: Statistical 
Associates Publishers. available online: 
http://www.statisticalassociates.com/measurement.htm
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• Use “Save file as” option 

Example: 
Data_2008_08_19, 

Data_2008_08_20

Output_2008_08_19

Output_2008_08_20
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Exercise 2

• Sort Cases / Select Cases / Split file 

Exercise 3

• Importing data into SPSS
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Exporting output

• Graphs
• Copy and Paste into standard apps (eg: Word, 

PowerPoint)

• File > Export to save as a picture format file 
(eg: jpeg, bitmap)

• Tables
• Word: Edit > Paste Special to paste as Word 

Table (default), plain text or picture

• PowerPoint: Edit > Paste Special to paste as 
picture (default) or formatted text
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Recoding

• Sometimes you want to change the 
values of an existing variable
– Recode the variable into itself

• Replaces old values with new values

– Recode the variable into a new variable
• Typically do this

– Unless you want to make the change permanent
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Data manipulation

• Compute
• Transform > Compute

• Create new variable according to a formula

• Doesn’t update automatically for any new 
cases or changed data

• Can use “Use Expression As Label” option to 
record the formula used

• Take care with missing values
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Exercise 4

• Data transformation

Time permitting 
Additional Exercises 5 & 6 

• Using syntax for data preparation

• Merging files
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SPSS – BOOKS (Hard copies)
* First Choice

• Chapters 1 & 2 in Allen, Peter James, & Bennett, Kellie. (2012). SPSS 
statistics : a practical guide : version 20. South Melbourne, Vic.: 
Cengage Learning Australia.

• Chapters 1, 2, 28 in Argyrous, George. (2011). Statistics for research : 
with a guide to SPSS (3rd ed.). Los Angeles: Sage.

• Chapter 1 in Landau, Sabine, & Everitt, Brian. (2004). A handbook of 
statistical analyses using SPSS. Boca Raton: Chapman & Hall/CRC.

• *Chapters 2 & 3 in Kinnear, Paul R., & Gray, Colin D. (2009). PASW 
statistics 17 made simple (replaces SPSS statistics 17). London ; New 
York: Psychology Press.

• Chapter 3 in in Field, Andy P. (2009). Discovering statistics using SPSS 
: (and sex, drugs and rock 'n' roll) (3rd ed.). Los Angeles: SAGE 
Publications.

• Chapters 2,3 - Norušis, M. J. (2008). SPSS 16.0 [or later versions] Guide 
to Data Analysis. Upper Saddle River, NJ: Prentice Hall.
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SPSS – BOOKS (Online copies) 
* First Choice

Hard copies and online versions

• * Chapters 2-4 & 8 in Pallant, Julie. (2010). SPSS survival manual a step 
by step guide to data analysis using SPSS (4th ed.). Maidenhead: Open 
University Press/McGraw-Hill.

• * Chapters 2, 3 & 5 in Morgan, George A. (2011). IBM SPSS for 
introductory statistics : use and interpretation (4th ed.). New York: 
Routledge.

Online versions

• Chapters 2 & 3 in Bryman, Alan, & Cramer, Duncan. (2011). Quantitative 
data analysis with IBM SPSS 17, 18 & 19 : a guide for social scientists. 
Hove ; New York: Routledge.

• Chapters 2 & 3 in Morgan, George A. (2011). IBM SPSS for introductory 
statistics : use and interpretation (4th ed.). New York: Routledge.

• Chapters 1 & 2 in Marston, Louise. (2010). Introductory statistics for 
health and nursing using SPSS. Los Angeles: SAGE.

• Chapter 1 in Larson-Hall, Jenifer. (2010). A guide to doing statistics in 
second language research using SPSS
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SPSS – Help and Resources
• SPSS has a range of help options 

available
– Topics

• Used to find specific information

– Tutorial
• Find illustrated, step-by-step 

instructions for the basic features

– Case studies
• Hands-on examples of various types of 

statistical procedures

– Statistics coach
• To help you find the procedure you 

want to use

And manuals available online -
http://www-
01.ibm.com/support/docview.wss?u
id=swg27021213
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SPSS – Online tutorials and resources
(!!! Please keep in mind that usually online resources are not academically peer 
reviewed. Despite many of them being of high quality as well as being  very useful 
from educational point of view, they shouldn’t be treated as a completely reliable 
and academically sound references)

- Statnotes: Topics in Multivariate Analysis, by G. David Garson 
http://www.statisticalassociates.com/

- UCLA Institute for Digital Research and Education - SPSS Starter Kit
http://www.ats.ucla.edu/stat/spss/sk/default.htm 

- Getting Started with SPSS for Windows by John Samuel, Indiana 
University 

http://www.indiana.edu/~statmath/stat/spss/win/index.html

- Companion Website for the 3rd edition of Discovering Statistics Using 
SPSS by Andy Field

http://www.uk.sagepub.com/field3e/SPSSFlashmovieslect.htm

- SPSS for Windows and Amos tutorials by Information Technology 
Services, University of Texas 

http://ssc.utexas.edu/software/software-tutorials#SPSS
- Journey in Survey Research by John Hall

http://surveyresearch.weebly.com/index.html
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SPSS – Help and Resources
• Online SPSS FORUMS

(!!! Please keep in mind that usually online resources are not academically peer 
reviewed. Despite many of them being of high quality as well as being  very useful 
from educational point of view, they shouldn’t be treated as a completely reliable 
and academically sound references. 

!!! Suggestions / Guidance found on forums should be especially 
treated very doubtfully, yet they may point to more reliable academic 
resources and be somewhat of help. 

Archives of SPSSX-L@LISTSERV.UGA.EDU –
List Serve that is endorsed by IBM SPSS
http://www.listserv.uga.edu/archives/spssx-l.html 

Other forums
http://groups.google.com/group/comp.soft-sys.stat.spss/topics?gvc=2 
http://www.spssforum.com/
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THANK YOU 

Please provide us with your feedback by 
completing the short survey. 


